
ЧАСТЬ IVСОЗДАНИЕ ГРАФИЧЕСКИХ 
ИЗОБРАЖЕНИЙ 
ДЛЯ ВСЕМИРНОЙ ПАУТИНЫ

В этой части

Глава 19. Основы создания графических изображений

Глава 20. Простые и эффективные веб-изображения





3

ГЛАВА 19

ОСНОВЫ СОЗДАНИЯ 
ГРАФИЧЕСКИХ 
ИЗОБРАЖЕНИЙ

Если вы не планируете публиковать сайты, содержащие исключитель-
но текст, то знание того, как создаются графические изображения для 
Всемирной паутины, вам просто необходимо. Для кого-то это будет но-
вый опыт: придется впервые открыть программу для редактирования 
изображений, чтобы приобрести базовые навыки в этой области. Но 
даже опытным дизайнерам, знакомым с допечатной подготовкой, мо-
жет понадобиться адаптировать собственный стиль и процесс изготов-
ления графики к производству изображений для Всемирной паутины.

В этой главе рассматриваются самые азы их получения, начиная со спо-
собов нахождения и создания изображений. Далее представлены сведе-
ния о форматах графических файлов, которые помогут решить, какой 
из них использовать. Также вы узнаете основополагающую информа-
цию о разрешениях, изменении размера и прозрачности изображений.

Как и в остальных главах, по ходу будут даны пошаговые упражнения. 
Хочу отметить, что я пишу этот материал, предполагая, что вы немного 
знакомы с какой-либо из программ для редактирования изображений. 
Для примеров и упражнений здесь использована программа Adobe 
Photoshop (наиболее распространенный графический редактор для 
веб-дизайна), но вы можете выполнять практически все шаги посред-
ством других инструментов, перечисленных в этой главе. Если вы на-
чинаете с нуля, то я рекомендую уделить время изучению какого-либо 
руководства по программе, которую собираетесь использовать.

Источники изображений

Чтобы вы могли сохранить рисунок, он должен быть у вас в наличии, 
так что перед тем, как мы перейдем к подробному описанию форматов 
файлов, давайте сначала взглянем на некоторые способы получения 
изображений. Их много: от сканирования, съемки или самостоятельно-
го создания иллюстраций до использования банков фотографий и кли-
парта или наема художника.

В этой главе

• Источники изображений

• Обзор форматов GIF, JPEG 
и PNG

• Размер и разрешение 
изображения

• Изменение размера 
изображений в программе 
Photoshop

• Бинарная и альфа-
прозрачность

• Знакомство с форматом SVG
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Создание ваших собственных изображений

В большинстве случаев самый эффективный способ получения изобра-
жений для вашего сайта — это создать собственные с нуля. Плюс в том, 
что у вас будут все права на их использование (скоро мы снова затро-
нем вопрос авторских прав). Цифровые фотокамеры

Вы можете запечатлеть мир вокруг вас при помощи цифровой фото-
камеры и отправить снимок прямо в программу для редактирования 
изображений. В зависимости от типа изображения вы можете получить 
фотографии подходящего качества даже при помощи компактной циф-
ровой фотокамеры.

Электронные иллюстрации

При наличии навыков создания иллюстраций вы можете разработать 
собственную графику, используя приложения для редактирования фо-
тографий или рисования. Во врезке «Инструменты для обработки изо-
бражений» перечислены некоторые самые популярные графические 
программы, доступные сегодня. У каждого дизайнера есть свои соб-
ственные любимые инструменты и техники. Я иногда создаю логоти-
пы, иллюстрации и эффектные надписи в программе Adobe Illustrator, 
потом переношу их в программу Photoshop, чтобы создать версию фай-
ла специально для Всемирной паутины. Вы обнаружите, что полезно 
иметь под рукой версии изображения высокого качества для печати 
и тех приложений, где требуется высокое разрешение. Копии меньшего 
размера можно сохранять по мере необходимости.

Сканирование

Сканирование — прекрасный способ собрать исходный материал. Вы 
можете отсканировать практически все, от плоских предметов искус-
ства до трехмерных объектов. Однако не поддавайтесь искушению ис-
пользовать таким образом готовые изображения. Помните о том, что 
большинство из тех, что вы найдете, вероятно, защищены авторскими 
правами, то есть их нельзя использовать без разрешения, даже значи-
тельно изменив. Практическую информацию по этому вопросу вы най-
дете во врезке «Советы по сканированию».

Стоковые ресурсы фотографий и иллюстраций

Если вы не уверены в своих дизайнерских способностях или просто 
хотите начать с использования какого-либо интересного изображения, 
существует много коллекций готовых фотографий, иллюстраций, кно-
пок, объектов анимации и текстур, выставленных на продажу или даже 
бесплатных. Лицензии на стоковые фотографии и иллюстрации обычно 
делятся на две основные категории: с управляемым авторским правом 
(RM, Rights managed) и не требующие авторских выплат (RF, Royalty-
Free ).

Лицензия RM означает, что владелец авторских прав (или компания, 
представляющая его) контролирует, кто может копировать изображе-



Источники изображений

Глава 19. Основы создания графических изображений 5

ние. Для того чтобы использовать такое изображение, вы должны при-
обрести лицензию на его копирование для конкретного применения 
и на определенный период времени. Одно из преимуществ подобного 
лицензирования заключается в том, что вы можете приобрести эксклю-
зивные права на изображение в пределах определенной среды (такой 
как Всемирная паутина) или определенного бизнес-сектора (такого как 
индустрия здравоохранения или банковское дело). В то же время изо-
бражения с лицензией RM достаточно дорогостоящие. В зависимости 
от охвата и продолжительности лицензирования цена может состав-
лять многие тысячи долларов за одно изображение. Если вам не нужны 

Инструменты для обработки изображений

Далее кратко приведена вводная информация об инструментах работы 
с изображениями, наиболее популярных среди профессиональных гра-
фических дизайнеров. Помимо них существует много других программ, 
которые работают с графическими файлами; замечательно, если вы 
нашли ту, что подходит именно вам.

Adobe Photoshop

Для работы с фотографиями, текстурами и другими растровыми типами 
изображений большинство профессиональных дизайнеров предпо-
читают использовать Adobe Photoshop. Также этот редактор содержит 
множество функций, предназначенных для создания графических 
изображений для Всемирной паутины. Демонстрационные версии этой 
и других программ корпорации Adobe доступны по адресу www.adobe.
com/ru/downloads/.

Adobe Fireworks

Это одна из первых программ, разработанных специально для работы 
с графическими изображениями для веб-страниц. В ней есть инструмен-
ты для создания как векторных (на основе контуров), так и растровых (на 
основе пикселов) изображений.

Adobe Illustrator

Программа Illustrator является стандартом в сфере подготовки вектор-
ных иллюстраций как для печати, так и веб-дизайна. Она прекрасно 
взаимодействует с программой Photoshop.

Corel PaintShop Photo Pro

Если вы используете операционную систему Windows и ограничены 
в бюджете, программа PaintShop Photo Pro предлагает функциональ-
ность, аналогичную Photoshop за гораздо меньшие деньги. Вы можете 
найти демонстрационную версию на сайте www.corel.ru/product/.

GIMP

GIMP — бесплатный инструмент с открытым исходным кодом, предна-
значенный для редактирования изображений и схожий по функциональ-
ности с программой Photoshop. Он работает в операционных системах 
Linux, Windows XP и Vista, а также OS X. Получить более подробную ин-
формацию и загрузить пробную версию можно на сайте www.gimp.org.
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эксклюзивные права и вы хотите использовать изображение только во 
Всемирной паутине, стоимость, скорее всего, составит несколько сотен 
долларов, в зависимости от источника.

Если такой вариант все еще кажется вам слишком сложным, рассмо-
трите возможность использования творческих работ с лицензией RF 
(Royalty-Free ). Такие изображения можно получить за единовремен-
ную оплату, которая дает вам право их неограниченного использова-
ния. Однако имейте в виду, что данное изображение сможет использо-
вать каждый, кто приобрел такую же лицензию. Работы с лицензией 
RF продаются на стоковых ресурсах, таких как Getty Images, где до-
ступны изображения всего по 30 долларов за штуку, а на других — еще 
дешевле.

Есть способ получить бесплатные изображения. Для этого надо най-
ти фотографии и рисунки, опубликованные с лицензией СС (Creative 
Commons ). Существует несколько типов лицензий СС, поэтому обя-
зательно изучите условия. Одни художники позволяют бесплатно ис-
пользовать свои работы так, как вам захочется; другие просят, чтобы вы 
указали их авторство; третьи ограничивают использование изображе-
ния некоммерческими целями.

Далее приведен список нескольких моих любимых ресурсов для поис-
ка высококачественных фотографий и иллюстраций, но он, конечно же, 
не исчерпывающий. Поиск во Всемирной паутине позволит вам найти 
намного больше сайтов с изображениями на продажу.

Flickr Creative Commons (www.flickr.com/creativecommons/)

Сервис для размещения фотографий Flickr — первый ресурс, куда я за-
хожу в поисках фотографий с лицензией СС (Creative Commons). Их 
качество различно, но обычно мне удается найти то, что нужно. Попро-
буйте применить инструмент поиска Compfight (compfight.com) для 
поиска интересных изображений на этом ресурсе.

iStockPhoto (www.istockphoto.com)

Если вы ограничены в средствах (и даже если это не так), нет лучше-
го места для поиска изображений, чем iStockPhoto. Цены начинаются 
всего от доллара за изображение! Это мой любимый сайт стоковых изо-
бражений.

Getty Images (www.gettyimages.com)

Ресурс Getty Images является крупнейшей базой изображений, которая 
поглотила бо́льшую часть своих конкурентов за последние годы. Сайт 
предлагает работы по лицензиям RM и RF в различном ценовом диа-
пазоне.

Veer (www.veer.com)

Мне нравится ресурс Veer потому, что он немного более стильный, чем 
сайты конкурентов. Этот сайт предлагает фотографии, иллюстрации, 
шрифты и видео по лицензиям RM и RF.

СОВЕТЫ ПО СКАНИРОВАНИЮ

Если вы сканируете изображе-
ния для использования на веб-
страницах, эти советы помогут 
вам добиться лучшего качества.

• Как правило, качество изо-
бражения проще сохранить 
в том случае, когда вы не 
увеличиваете, а умень-
шаете его размер. Поэтому 
лучше сканировать изо-
бражение, которое немного 
крупнее, чем вам нужно. 
Это предоставит больше 
возможностей для даль-
нейшего изменения его 
размера. Более подробно 
эти вопросы мы обсудим 
далее в этой главе в раз-
деле «Размер и разрешение 
изображений».

• Сканируйте черно-белые 
изображения в режиме 
градаций серого (8 бит), но 
не в черно-белом (1 бит). 
Это позволит вам вносить 
изменения в полутона до 
установки окончательных 
размера и разрешения. Если 
же вы на самом деле хотите 
получить пикселы только 
черного и белого цвета, 
конвертируйте изображение 
в соответствующий режим 
на последнем шаге.

• У напечатанного изобра-
жения может оказаться 
заметная точечная струк-
тура, которую потребуется 
устранить после сканирова-
ния. Лучший способ сделать 
это — применить легкое 
размытие. Например в про-
грамме Photoshop исполь-
зуйте фильтр Размытие 
по Гауссу (Gaussian Blur), 
слегка уменьшите размер 
изображения, а затем при-
мените фильтр Усиление 
резкости (Sharpen).

Также обязательно убедитесь, 
что у вас есть авторские права 
на использование этих изобра-
жений.
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Клипарт

Клипарт  — это коллекции иллюстраций, анимаций, кнопок и других 
подобных объектов, не требующих авторских выплат. Во Всемирной 
паутине существует большое количество ресурсов с клипартами, и хо-
рошая новость в том, что некоторые из них раздают графику бесплатно. 
На других сайтах осуществляется платное членство, от 10 до 200 долла-
ров в год. К сожалению, многие изображения там плохого качества или 
примитивные (однако о вкусах не спорят). Ниже я привела несколько 
подобных сайтов.

Clipart.com (www.clipart.com)

Доступ к сервису предоставляется после оплаты членских взносов, но 
ресурс хорошо организован и предлагает изображения более высокого 
качества, чем бесплатные сайты.

#1 Free Clip Art (www.1clipart.com)

Предлагает клипарт без излишеств, зато бесплатно.

Найти бесплатные или дешевые значки для веб-страниц и приложений 
также несложно (для этого просто введите запрос «значки для веб-
сайтов» или «free icons web-site» в любой из поисковых систем). Ниже 
представлены два ресурса, специализирующиеся именно на такиех ти-
пах изображений.

The Noun Project (thenounproject.com)

Собирает и систематизирует классические одноцветные значки со все-
го мира и предоставляет их бесплатно.

Icon Finder (www.iconfinder.com)

Огромная база бесплатных полноцветных иконок в любом стиле. Обя-
зательно прочитайте условия лицензии Creative Commons, они меня-
ются в зависимости от набора.

Наем дизайнера

Поиск и создание изображений отнимает время, а также требует нали-
чия определенного таланта. Если у вас приличный бюджет, рассмотри-
те возможность наема графического дизайнера, фотографа или иллю-
стратора, чтобы он создал изображения для вашего сайта. Но даже если 
вы начнете с набора оригинальных фотографий или иллюстраций, то 
вам все равно пригодятся, которые вы приобретете при помощи этой 
книги, чтобы создавать версии изображений для Всемирной паутины, 
когда они вам потребуются.

ПРИМЕЧАНИЕ

Подробнее о лицензиях СС читай-
те на сайте creativecommons.
org/licenses/.
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Знакомство с форматами

Знакомство с форматами

Как только у вас появились изображения, нужно привести их в формат, 
который поддерживается на веб-страницах. Существуют десятки фор-
матов графических файлов. Например если вы используете операцион-
ную систему Windows, вам могут быть знакомы файлы формата BMP, 
или, если вы работали в программе допечатной подготовки, то могли 
часто использовать изображения формата TIFF и EPS. Во Всемирной 
паутине растровые (пиксельные) изображения необходимо сохранять 
в одном из трех форматов: GIF (произносится как «джиф» или «гиф»), 
JPEG («джэй-пег») и PNG («пинг» или «пэ-эн-джи»).

Существует и четвертый формат, о котором я хочу вам рассказать — 
SVG (масштабируемая векторная графика), который немного необы-
чен тем, что представляет собой векторный рисунок, сгенерированный 
текстовым файлом XML, поэтому я приберегу этот формат на конец 
главы. Тем временем мы сосредоточимся на универсально поддержи-
ваемых растровых форматах изображений GIF, JPEG и PNG.

Если эти слова звучат для вас как абракадабра, не беспокойтесь. К кон-
цу данной части, вы будете знать, чем отличается GIF от JPEG, и когда 
какой формат нужно использовать. Ниже приведена краткая информа-
ция:

GIF  — формат, который наиболее подходит изображениям с однотон-
ными областями и резкими цветовыми переходами, а также когда ис-
пользуются прозрачные области или анимация.

JPEG  — лучше всего подходит для фотографий или изображений 
с плавными цветовыми переходами.

PNG  — файлы такого типа могут содержать любые типы изображений, 
но особенно этот формат хорош для сохранения изображений с одно-
тонными областями цвета. PNG — единственный формат, позволяю-
щий использовать несколько уровней прозрачности.

В этой главе мы рассмотрим терминологию и подробнее разберем ха-
рактеристики и функции каждого формата. Понимание технических 
деталей поможет вам создавать графические изображения самого вы-
сокого качества при наименьших размерах.

Формат GIF

Файлы формата GIF  (Graphic Interchange Format — формат для обмена 
изображениями) чаще всего используются для веб-страниц. Несмотря 
на то что он не был создан специально для Всемирной паутины, этот 
формат быстро приняли за его универсальность, небольшой размер 
файлов и межплатформенную совместимость. Также GIF предполагает 
прозрачность и способен содержать простую анимацию. Прошло более 
двадцати лет, но он, бесспорно, остается наиболее широко используе-
мым форматом изображений для Всемирной паутины.

Именуйте файлы 
правильно

Убедитесь, что используете 
правильные расширения для 
файлов с изображениями. Фай-
лы GIF должны иметь расшире-
ние .gif, файлы JPEG — .jpg (или 
менее распространенное .jpeg), 
а файлы PNG должны закан-
чиваться расширением .png. 
Браузеры используют расшире-
ние, чтобы определить, как об-
ращаться с различными типами 
мультимедийных файлов, так 
что необходимо придержи-
ваться указанных расширений 
для форматов файлов изобра-
жений.
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Поскольку алгоритм сжатия GIF отличается сжатием однотонных цве-
тов, то это лучший формат файла для сохранения логотипов, штриховых 
рисунков, графических текстовых надписей, значков и т. д. (рис. 19.1). 
Вы также можете сохранять фотографии или текстурные изображения 
в формате GIF, но это будет не столь эффективно, поскольку в резуль-
тате получатся файлы большего размера. Тем не менее GIF отлично 
подходит для изображений с комбинацией небольших фрагментов 
фото и больших областей однотонного цвета.

Чтобы правильно сохранить файл в формате GIF, важно знать, как он 
работает и что он может сделать.

Рис. 19.1. Формат GIF лучше всего подходит для изображений 
с однотонными цветами и резкими переходами цвета

8 бит, индексированный цвет

Говоря техническим языком, файлы в формате GIF — это изображения 
с индексированным цветами, которые содержат 8-битную информа-
цию о цвете (их также можно сохранить с более низкой разрядностью 
цвета). Расшифруем эти термины. 8 бит означает, что файл GIF может 
содержать до 256 цветов — максимальное количество, которое могут 
описать 8 бит информации (28=256). Использование меньшей глубины 
цвета ведет к меньшему количеству воспроизводимых цветов, а также 
сокращает размер файла.

Индексированный цвет  означает, что набор цветов изображения, его па-
литра, хранится в таблице цветов (которую также называют картой 
цвета). Каждый пиксел в изображении содержит цифровую ссылку 
(или «индекс») на позицию в таблице цветов. Это станет понятно после 
простой демонстрации. Рис. 19.2 показывает, как 2-битное (4-цветное) 
изображение с индексированным цветом соотносится с таблицей цве-
тов. У 8-битных изображений в таблице цвета 256 ячеек.
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The pixels in an indexed color image
contain numerical references to the
color table for the image.

The image displays with the
colors in place.

The color table matches
numbers to RGB color
values. This is the map for a
2-bit image with only
4 colors.

Color tableТаблица цветов

Пикселы в изображении с индексиро-
ванным цветом содержат цифровые 
ссылки на таблицу цветов изображения.

Вид изображения с цветами на своих 
местах.

Таблица цветов соответ-
ствует числам цветовых 
значений RGB. Это карта 
для 2-битного изображения 
всего лишь с четырьмя 
цветами.

Рис. 19.2. 2-битное изображение и его таблица цвета

Когда открываете файл формата GIF в программе Photoshop, вы 
способны видеть (и даже редактировать) его таблицу цвета, вы-
брав команду меню Изображение ⇒ Режим ⇒ Таблица цветов 
(Image ⇒ Mode ⇒ Color Table) (рис. 19.3). Вы сможете просмотреть 
таблицу цветов изображения, если в программе Photoshop выберете 
команду меню Файл ⇒ Сохранить для Web и устройств (File ⇒ Save 
for Web & Devices), чтобы экспортировать изображение в формат GIF, 
как мы будем делать далее в этой главе. В программе Fireworks таблица 
цветов находится на панели Оптимизировать (Optimize).

Photoshop Fireworks

 

 

Рис. 19.3. Вид таблицы цветов в программах Photoshop и Fireworks отображает 64 пиксельных цвета, 
использованных в изображении
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Основные цветовые палитры

Все изображения в режиме 8-битного индексирован-
ного цвета, включая GIF и PNG, используют палитры 
для определения цветов, причем существует несколь-
ко стандартных палитр на выбор . Некоторые методы 
предполагают создание пользовательской палитры, 
основанной на цветах, используемых в изображении. 
Другие применяют предварительно созданную палитру.

Точная (Exact). Состоит из фактических цветов изобра-
жения, если оно содержит менее 256 цветов.

Адаптивная (Adaptive). Использует наиболее часто 
встречающиеся в изображении цвета пикселов. Это 
позволяет сокращать глубину цвета, сохраняя ориги-
нальный вид изображения.

Перцепционная (Perceptual) (только в программе 
Photoshop). Отдает приоритет тем, к которым наи-
более восприимчив человеческий глаз. В отличие от 
адаптивной, эта палитра основывается на алгоритмах, 
а не только на подсчете пикселов. В результате обычно 
получаются изображения с лучшей цветовой интегра-
цией, чем изображения с адаптивной палитрой.

Селективная (Selective) (только в программе 
Photoshop). Похожа на перцепционную, но отдает 
предпочтение широким областям цвета и сохранению 
цветов, безопасных для Всемирной паутины.

Веб-безопасная (Web Adaptive), Ограниченная 
(Restrictive) или Web216 (Web216). Формируются 
исключительно из палитры цветов, включающей 216 
цветов, которые не искажаются на 8-битных монито-
рах. 8-битные мониторы остались в прошлом, поэтому 
веб-безопасная палитра больше не актуальна и не 
рекомендуется.

Заказная (Custom). Эта команда позволяет вам загру-
жать палитру, которая была предварительно сохране-
на, и применять ее к текущему изображению. В про-
тивном случае она сохраняет в палитре текущие цвета.

Системная (System) (в операционных системах 
Windows или OS X). Использует цвета из определенной 
системной палитры по умолчанию.

Оптимизированный медианный вырез (Optimized 
Median Cut) (только в программе PaintShop Pro Photo). 
Cокращает количество цветов в изображении до 
нескольких, используя нечто сходное с адаптивной 
палитрой.

Оптимизированное 8-уровневое дерево (Optimized 
Octree) (только в программе PaintShop Pro Photo). 
Используйте эту палитру, если в оригинальном изобра-
жении всего несколько цветов и вы хотите сохранить 
именно их.

Большинство исходных изображений (отсканированные, иллюстра-
ции, фотографии и т. д.) имеют исходный формат RGB, поэтому их 
нужно конвертировать в режим индексированного цвета, чтобы потом 
можно было сохранить в формате GIF. Когда изображение переходит 
из формата RGB в индексированный режим, количество цветов в изо-
бражении сокращается до 256 или меньшего. В программах Photoshop 
и Fireworks конверсия имеет место, когда вы сохраняете или экспорти-
руете документ в формат GIF. Другие программы для редактирования 
изображений могут потребовать, чтобы вы сначала конвертировали его 
вручную в индексированный цвет, а затем, в качестве второго шага, экс-
портировали в формат GIF.

В любом случае вам нужно будет выбрать палитру для изображения 
с индексированным цветом. Врезка «Основные цветовые палитры» 
описывает различные палитры, доступные в наиболее популяр-
ных инструментах работы с изображениями. Я рекомендую вам ис-
пользовать селективную или перцепционную палитру в программе 
Photoshop, адаптивную — в программе Fireworks, и режим Оптими-
зированный медианный вырез (Optimized Median Cut) в программе 
PaintShop Pro для получения лучшего результата для большинства 
изображений.
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Сжатие файлов формата GIF

Сжатие файлов формата GIF осуществляется без потерь, это означает, 
что никакая информация об изображении при этом не теряется (хотя 
некоторая информация об изображении все же может быть потеряна, 
если изображение формата RGB конвертируется в файл с индексиро-
ванным цветом). Кроме того, этот формат использует схему сжатия 
(называемую LZW — алгоритм Лемпеля-Зива-Велча), применяющую 
повторение данных. При обнаружении строки пикселов идентичного 
цвета строка сжимается в одно описание данных. Вот почему изображе-
ния с большими областями равномерного цвета легче поддаются сжа-
тию, чем текстурные.

Объясню это на упрощенном примере: когда при сжатии находится 
ряд из 14 идентичных пикселов синего цвета, выполняется сокра-
щенная запись «14 синих пикселов». В следующий раз, когда встре-
чаются 14 синих пикселов, используется только кодовое сокращение 
(рис. 19.4). И наоборот, если встречается ряд с плавным переходом от 
синего к голубому и зеленому, необходимо сохранить описание каж-
дого пиксела, для чего требуется больше данных. То, что происходит, 
в технических терминах объяснить сложнее, но этот пример представ-
ляет собой рекомендацию, о которой нужно помнить, когда вы соз-
даете изображения в формате GIF и хотите добиться максимального 
сжатия.

In an image with gradations of color, it has to store
information for every pixel in the row. The longer
description means a larger file size.

GIF compression stores repetitive pixel colors
as a single description.

“14 blue”

“1 blue, 1 aqua, 2 light aqua...” (and so on)

При сжатии в формате GIF повторяющиеся цвета 
пикселов сохраняются в виде одного описания.

В изображении с градациями цвета необходимо 
хранить информацию отдельно для каждого пик-
села в строке. Более длинное описание означает 
файл большего размера.

«14 синих»

«1 синий, 1 голубой, 2 светло-голубых и т. д.»

Рис. 19.4. Упрощенная демонстрация алгоритма сжатия LZW, 
который используется в изображениях формата GIF

Прозрачность

Вы можете сделать некоторые области изображения формата GIF 
прозрачными, так, чтобы фоновое изображение или цвет страницы 
были видны. Хотя вся растровая графика является прямоугольной от 
природы, при помощи прозрачности вы можете создавать иллюзию, 
что ваше изображение имеет более интересную форму (рис. 19.5). 
Прозрачность файлов GIF мы будем подробно обсуждать далее в этой 
главе.

Рис. 19.5. Благодаря 
прозрачности 
фон страницы 
«просвечивает» сквозь 
изображение (внизу)
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Чересстрочная загрузка

Чересстрочная загрузка  заставляет файл в формате GIF загружаться 
в несколько стадий. Каждая демонстрирует более ясное изображение, 
чем предыдущее, до того момента, пока изображение полностью не загру-
зится в окне браузера (рис. 19.6). Без чересстрочной загрузки некоторые 
браузеры могут ожидать окончания загрузки изображения до того, как 
покажут его. Другие могут выводить по несколько строк изображения за 
раз, сверху вниз, до того момента, пока оно не появится полностью.

При высокоскоростном соединении эти эффекты (чересстрочная за-
грузка или задержка появления изображения) могут быть вообще не-
заметны. Однако при медленных коммутируемых соединениях черес-
строчная загрузка больших изображений может быть намеком, что 
постепенно проявляющееся изображение скоро будет получено.

Используете ли вы чересстрочную загрузку или нет — это ваше реше-
ние. Я никогда не использую, но если у вас особенно большое изобра-
жение и аудитория со значительным процентом коммутируемых сое-
динений, чересстрочная загрузка может оказаться полезной.

Анимация

Еще одной особенностью, которой обладает файл формата GIF, яв-
ляется способность демонстрировать простую анимацию  (рис. 19.7). 
Многие из крутящихся, мигающих, исчезающих или как-то иначе дви-
гающихся рекламных баннеров, которые вы видите, являются аними-
рованными файлами GIF (хотя ролики в формате Flash становятся все 
более популярными).

Рис. 19.7. Все кадры этой простой анимации содержатся в одном 
файле формата GIF

Анимированные файлы GIF содержат определенное количество кадров 
анимации, представляющих собой отдельные изображения, которые, 
когда их просматривают друг за другом на большой скорости, создают 
иллюзию движения или изменения с течением времени. Все эти изо-
бражения хранятся внутри одного GIF-файла наряду с параметрами, 
которые описывают, как они должны проигрываться в окне браузера. 
Настройки описывают, как и сколько раз должна повторяться последо-
вательность, как долго каждый кадр остается видимым (задержка кадра), 
способ, которым один кадр заменяет другой (метод удаления), является 
ли изображение прозрачным и используется ли чересстрочная загрузка.

Программы Adobe Photoshop и Fireworks имеют инструменты для соз-
дания анимированных GIF-файлов. В программе Photoshop CS5 и более 

Рис. 19.6. Изображение 
GIF появляется через 
серию переходов, каждый 
демонстрирует более ясное 
изображение, чем предыдущее
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ранних версиях используйте окно Анимация (Animation). В CS6 ис-
пользуйте окно Шкала времени (Timeline) и выберите команду Создать 
анимацию кадра (Create Frame Animation). Во Всемирной паутине для 
работы с анимированными файлами GIF можно найти множество спе-
циализированных инструментов, многие из которых бесплатные.

Формат JPEG

Второй по популярности графический формат во Всемирной паути-
не — это JPEG  (Joint Photographic Experts Group — объединенная груп-
па экспертов по фотографии).

В отличие от формата GIF, JPEG использует алгоритм сжатия, подхо-
дящий для градиентов и смешений оттенков, но не особенно хорошо 
обрабатывающий однотонные цвета или резкие цветовые переходы. 
Способность отображать все цвета и алгоритм сжатия делают JPEG 
идеальным выбором для фотографий (рис. 19.8).

Рис. 19.8. Формат JPEG идеально подходит для фотографий (цветных 
или в градациях серого) или любого изображения с тонкими переходами 
цвета

ПРЕДУПРЕЖДЕНИЕ

На момент написания книги 
возникали проблемы с отобра-
жением анимированных файлов 
в формате GIF на телефонах 
на базе Android и планшетах. 
И хотя в операционной системе 
Android 2.2 была добавлена под-
держка анимированных файлов 
GIF, многие производители теле-
фонов по умолчанию отключают 
ее, считая, что пользователи 
сами знают, как включить эту 
функцию в настройках (что 
маловероятно). Браузер Opera 
Mobile версии 10 и выше под-
держивает анимированные 
GIF-файлы, а Opera Mini — нет. 
На устройствах под управлени-
ем операционной системы iOS 
анимированные GIF-файлы ото-
бражаются замечательно.

ДЛЯ ДАЛЬНЕЙШЕГО ЧТЕНИЯ

Анимированные изображения GIF

Если вы хотите больше узнать о создании анимированных файлов 
формата GIF, можете открыть PDF-файл «Приложение В. Создание ани-
мированных GIF-файлов». Оно включает в себя детальные объяснения 
настроек анимации и пошаговые инструкции по ее созданию.
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24-битные изображения истинного цвета

Формат JPEG не использует цветовые палитры, как GIF. Вместо этого 
файлы JPEG являются 24-битными изображениями, способными ото-
бражать миллионы оттенков в цветовом пространстве RGB (оно также 
называется пространством истинного цвета (Truecolor), см. примеча-
ние). Основной аспект, который делает этот формат идеальным для 
фотографий — доступны все цвета, которые вам когда-нибудь вообще 
могут понадобиться.

С форматом JPEG вам не придется беспокоиться об ограничении в 256 
цветов, как это происходит с файлами формата GIF.

Сжатие с потерями

Алгоритм сжатия JPEG вызывает потери в качестве, которые означа-
ют, что часть информации об изображении отбрасывается в процессе 
компрессии. К счастью, эти потери незаметны для многих изображений 
на большинстве уровней сжатия. При высокой степени сжатия на изо-
бражении появляются пятна и квадраты другого цвета (их принято на-
зывать артефактами ), которые возникают в зависимости от того, как 
алгоритм сжатия захватывает образцы изображения (рис. 19.9).

Оригинал Максимальное сжатие

Рис. 19.9. Алгоритм сжатия файлов JPEG отбрасывает 
детали изображения, чтобы добиться меньшего размера файла. 
При высокой степени сжатия страдает качество изображения, 
как показано на рисунке справа

Вы можете контролировать, насколько сильно должно быть сжато изо-
бражение. Это подразумевает компромисс между размером файла и ка-
чеством. Чем больше вы сжимаете изображение (для получения файла 
меньшего размера), тем больше страдает качество. И наоборот, когда 
вы максимизируете качество, вы в результате получаете файл большего 
размера. Выбор оптимального уровня сжатия зависит от конкретного 
изображения и ваших целей на сайте. Стратегии выбора уровня сжатия 
мы подробно обсудим в главе 20.

ПРИМЕЧАНИЕ

Информация о цветовой модели 
RGB приведена в главе 13.

ВНИМАНИЕ!

Кумулятивная потеря 
качества изображения

Обратите внимание на то, что 
как только качество изобра-
жения потеряно после сжатия 
файла JPEG, вы никогда его не 
восстановите. По этой причине 
вам лучше избегать повторного 
сохранения файла в формате 
JPEG. Иначе каждый раз вы 
будете терять в качестве изо-
бражения.

Лучше работать с оригинальным 
изображением и при необхо-
димости делать копии JPEG. 
Таким образом, если нужно 
внести изменения, вы можете 
вернуться к оригиналу и сделать 
новое сохранение или экспорт. 
К счастью, функция програм-
мы Photoshop Сохранить для 
web и устройств (Save for Web 
& Devices) предназначена 
именно для этой цели. Програм-
ма Fireworks также сохраняет 
оригиналы и позволяет вам 
создавать или экспортировать 
копии.
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Прогрессивное представление данных JPEG

Прогрессивное представление данных JPEG  показывает изображение 
через серию шагов (как и в случае чересстрочной загрузки файлов в фор-
мате GIF), начиная с версии с низким разрешением, которая становится 
четче с каждым шагом, как показано на рис. 19.10. В некоторых графиче-
ских программах вы можете указать количество переходов, которые по-
требуются перед демонстрацией итогового изображения (3, 4 или 5).

Рис. 19.10. При прогрессивном представлении данных изображение 
JPEG проявляется через серию шагов

Преимущество использования прогрессивного представления данных 
JPEG заключается в том, что те, кому адресовано изображение, получат 
представление о нем до того, как рисунок полностью загрузится. Также, 
если вы решите сделать файл JPEG прогрессивным, это немного сократит 
его размер. Недостаток же в том, что для прогрессивного представления 
данных требуется больше ресурсов компьютера, и вывод изображения 
итогового качества может быть замедлен. Кроме того, это существенно 
затруднит загрузку картинок на недорогих мобильных устройствах.

Декомпрессия

Файлы формата JPEG должны быть преобразованы перед демонстра-
цией, поэтому браузеру нужно больше времени, чтобы декодировать 
и собрать файл формата JPEG, чем GIF такого же размера. Обычно это 
незаметно для конечного пользователя и не должно стать причиной иг-
норирования формата JPEG. Тем не менее вам следует об этом знать.

Формат PNG

Последний графический формат, предназначенный для хранения изо-
бражений для Всемирной паутины, — это универсальный PNG  (Portable 
Network Graphic — Портативная сетевая графика). Несмотря на его 
поначалу медленное развитие, PNG в настоящее время поддерживает-
ся всеми браузерами и становится любимым графическим форматом 
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многих разработчиков. Формат PNG предлагает впечатляющий список 
возможностей:

• Содержать 8-битные индексированные и 24-битные в режиме RGB, 
16-битные в режиме градаций серого и даже 48-битные цветные 
изображения;

• Алгоритм сжатия без потерь;

• Простое включение/выключение прозрачности (как в формате 
GIF) или многослойная прозрачность;

• Чересстрочное отображение (сходное с чересстрочной загруз-
кой GIF);

• Гамма-коррекция;

• Возможность добавлять встроенный текст с информацией о созда-
теле, авторских правах и т. п.

В этом разделе мы подробнее рассмотрим каждую из этих функций, что 
поможет вам разобраться, когда формат PNG является лучшим выбо-
ром для вашего изображения.

Различные форматы изображений

Формат PNG был разработан, чтобы заменить формат GIF для публика-
ции изображений во Всемирной паутине, и формат TIFF для хранения 
и печати изображений. Файлы формата PNG позволяют сохранять мно-
гие режимы изображений: 8-битные индексированные цвета, 24- и 48-
битные цвета RGB, и 16-битные изображения в режиме градации серого.

8-битные изображения с индексированным цветом

Как и GIF, файлы формата PNG могут содержать 8-битные изображе-
ния максимум с 256 цветами. Их также можно сохранить с глубиной 
цвета 1, 2 и 4 бит. Такие файлы обычно называют PNG-8.

RGB/Truecolor (24 и 48 бит)

В изображении формата PNG каждый канал (красный, зеленый и си-
ний) может быть определен посредством 8- или 16-битной информа-
ции, в результате получаются 24- или 48-битные изображения RGB, со-
ответственно. В графических программах 24-битные RGB файлы PNG 
идентифицируются как PNG-24. Следует отметить, что 48-битные 
изображения бесполезны для Всемирной паутины, и даже 24-битные 
изображения надо использовать с осторожностью. Поскольку сжатие 
происходит без потери качества, 24-битные PNG файлы почти всегда 
значительно большего размера, чем файл с тем же изображением в фор-
мате JPEG, сжатый с потерей качества.

Градации серого

Формат PNG также может поддерживать 16-битные изображения 
в градациях серого — это больше, чем 65 536 оттенков серого (216), ко-
торые дают возможность черно-белым фотографиям и иллюстрациям 

Использование фай-
лов с прогрессивным 
представлением JPEG 
на дисплеях Retina

Вообще, необязательно сохра-
нять файл JPEG с прогрессив-
ным представлением. Исклю-
чением из данного правила 
(на момент написания книги) 
являлись случаи, когда созда-
вались файлы JPEG двойного 
размера, ориентированные 
на устройства с операционной 
системой iOS и экранами (дис-
плеями) Retina. В этом случае 
их необходимо сохранить 
в прогрессивном формате, 
чтобы обойти ограничение на 
размер в байтах в браузере 
Safari. Возможно, этот обход-
ной путь больше не потребуется 
для будущих версий браузера 
Safari и когда дисплеи Retina 
станут более распространен-
ными. Другие размышления 
по этому вопросу обсуждаются 
во врезке «Дисплеи с высокой 
плотностью пикселов».
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включать огромное количество тонкостей и деталей, хотя этот формат 
и не подходит для Всемирной паутины.

Прозрачность

Формат PNG может содержать прозрачные области, которые позво-
ляют видеть фоновое изображение. Преимущество, которым обладает 
PNG по отношению к GIF, заключается в его способности содержать 
множественные уровни прозрачности, обычно их называют прозрач-
ность альфа-канала  или просто альфа.

Рис. 19.11 демонстрирует одно и то же изображение в формате PNG 
на фоне двух разных изображений. Оранжевый круг полностью не-
прозрачный, но тень содержит несколько уровней прозрачности, начи-
ная от практически непрозрачного до практически 100%-прозрачного. 
Многоуровневая прозрачность, содержащаяся в изображении форма-
та PNG, позволяет тени плавно сливаться с любым фоном. Детальная 
информация о прозрачности формата PNG будет представлена далее 
в разделе «Работа с прозрачностью».

Рис. 19.11. Прозрачность альфа-каналов предоставляет возможность 
создать многоуровневую прозрачность, как у тени вокруг оранжевого 
круга формата PNG

Чересстрочное отображение (интерлейсинг)

Формат PNG также можно настроить на чересстрочное отображение. 
Если вы выбрали эту функцию, изображение будет появляться через 
серию из семи шагов. В отличие от процесса вывода изображений фор-
мата GIF, которые заполняют горизонтальные ряды, изображение PNG 
заполняется и горизонтально, и вертикально. Эта особенность уве-
личивает размер файла и обычно не является необходимой, поэтому 
отключите чересстрочное отображение, если хотите сохранить мини-
мальный размер.

Гамма-коррекция

Гамма  относится к настройке яркости монитора. Поскольку настройки 
гаммы различаются в зависимости от платформы, графика, которую 
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вы создаете, для конечного потребителя может выглядеть не такой, как 
вы хотели. Изображениям PNG можно присвоить информацию о на-
стройках гаммы среды, в которой они были созданы. Затем програм-
мы интерпретируют эту информацию, отображая рисунок в формате 
PNG с соответствующей коррекцией. Когда это выполнено на сторо-
нах разработчика и потребителя, изображение формата PNG сохраня-
ет должную яркость и насыщенность цвета. К сожалению, на момент 
написания этой книги, данная функция в реальности не работала так, 
как задумано. Браузер Internet Explorer (все версии) отображал гам-
му некорректно, а файлы в формате PNG в итоге оказывались темнее, 
чем планировалось. Редактор Photoshop, начиная с версии CS3, пере-
стал включать информацию о гамме в файлы PNG. Помните, что может 
оказаться нелегко подобрать файл PNG, сочетающийся с цветом фона 
в некоторых браузерах, даже если значения RGB будут одинаковые. 
Решение — сделать края изображения в формате PNG прозрачными, 
чтобы фон просматривался сквозь них, или использовать формат GIF.

Встроенный текст

Формат PNG также дает возможность хранить текстовые данные. Это 
полезно для перманентного присоединения текста к рисунку, например 
сведений об авторских правах или описания того, что находится на изо-
бражении. Единственные инструменты, которые размещают текстовые 
аннотации в файлах формата PNG — это программы Corel PaintShop 
Pro и GIMP. В идеале, метаинформация в файле формата PNG мо-
жет быть доступна по щелчку правой кнопкой мыши по изображению 
в браузере, но данная функция внедрена еще не во всех современных 
браузерах.

Когда использовать PNG

Формат PNG  предлагает много мощных функций, но соревнование 
между форматами для графических изображений практически всегда 
сводится к вопросу о размере файла. Для изображений, которые сохра-
няются в формате GIF, 8-битный PNG является лучшей альтернативой. 
Вы можете обнаружить, что изображение PNG имеет меньший размер, 
чем тот же файл в формате GIF, но это зависит от того, насколько эф-
фективно ваша программа по обработке изображений использует алго-
ритм сжатия PNG.

Хотя формат PNG и поддерживает изображения с 24-битным цветом, 
его алгоритм сжатия без потерь практически всегда в результате при-
водит к значительно большему размеру файла, чем при сжатии JPEG, 
применяемому к тому же самому изображению. Для Всемирной паути-
ны формат JPEG остается лучшим выбором в отношении фотографий 
и изображений с непрерывным спектром тонов.

Исключением из правила «побеждает самый маленький файл» яв-
ляется тот случай, когда вы хотите воспользоваться преимуществом 
многоуровневой прозрачности. В этом случае формат PNG является 

ПРИМЕЧАНИЕ

Если вы предпочитаете формат 
PNG и обязательно требуете хо-
рошего качества, можете удалить 
из файла информацию о гамме 
(gAMA) с помощью такой програм-
мы, как PNGcrush, о чем подробно 
рассказывается в статье Трэвора 
Морриса (morris-photographics.
com/photoshop/articles/png-
gamma.html).
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единственным выбором и стоит того, чтобы размер файла немного уве-
личился.

В следующем разделе мы детально рассмотрим вопрос выбора наибо-
лее подходящего графического формата для вашего проекта.

Выбор подходящего формата изображений

Важным моментом при создании качественных и быстро загружаю-
щихся графических изображений для Всемирной паутины является 
выбор правильного формата. Табл. 19.1 содержит всю необходимую 
информацию для его осуществления.

Табл. 19.1. Выбор лучшего формата файла

Если ваше изобра-
жение...

Используйте... Потому что...

…графическое 
с однотонным 
цветом

GIF или 
8-битный PNG

Они отличаются способно-
стью сжатия однотонных 
цветов

…фотография или 
содержит гради-
енты

JPEG Алгоритм сжатия JPEG 
лучше всего подходит для 
изображений со смешанным 
цветом. Поскольку сжатие 
происходит с потерями, то 
обычно в результате получа-
ется файл меньшего размера, 
чем 24-битный PNG.

…комбинация 
однотонного цвета 
и фотографии

GIF или 
8-битный PNG

Форматы с индексирован-
ными цветами лучше всего 
подходят для сохранения 
и сжатия областей однотон-
ного цвета. Дизеринг, воз-
никающий на фотографиях, 
является результатом сокра-
щения палитры и обычно не 
вызывает проблем.

…требует прозрач-
ности

GIF или PNG И GIF и PNG позволяют соз-
давать/убирать прозрачность 
на изображении.

…требует много-
уровневой про-
зрачности

PNG PNG — единственный фор-
мат, который поддерживает 
прозрачность альфа-каналов.

…требует анима-
ции

GIF GIF — единственный формат, 
который может содержать 
кадры анимации.

Работа в режиме RGB

Независимо от итогового 
формата файла вы всегда 
должны редактировать изобра-
жения в режиме RGB  (подойдет 
и режим градации серого для 
черно-белых изображений). 
Чтобы проверить режим цвета 
изображения в программе 
Photoshop, раскройте меню 
Изображение ⇒ Режим 
(Image ⇒ Mode) и убедитесь, 
что установлен флажок RGB.

Файлы JPEG и PNG-24 напря-
мую сжимают изображения 
в цвета RGB. Если вы сохра-
няете файл в формате GIF или 
PNG-8, то изображение форма-
та RGB должно быть конверти-
ровано в режим индексирован-
ных цветов — либо вручную, 
либо как часть процесса, 
выполняемого посредством 
команд Сохранить для Web 
и устройств (Save for Web) или 
Экспортировать (Export).

Если вам нужно отредактиро-
вать существующее изображе-
ние формата GIF или PNG-8, вы 
должны конвертировать изобра-
жение в режим RGB перед тем, 
как вносить какую-либо правку. 
Это дает возможность использо-
вать при работе с изображени-
ем цвета полного спектра RGB.

Если вы меняете размер 
оригинального изображения 
с индексированными цветами, 
то получите плохой результат, 
поскольку новое изображение 
будет ограничено существую-
щей цветовой таблицы.

Если у вас есть опыт создания 
изображений для печати, вы 
могли привыкнуть работать 
в режиме CMYK (цвета при пе-
чати состоят из чернил голубо-
го, пурпурного, желтого и черно-
го цвета (Cyan, Magenta, Yellow, 
blacK). Он не подходит для 
Всемирной паутины, поэтому 
прежде чем начать редактиро-
вание, следует конвертировать 
изображение в режим RGB.
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Сохранение изображений в выбранном 
вами формате

Практически каждая современная программа для обработки графики 
позволяет сохранять изображения в формате GIF, JPEG и PNG, но не-
которые предоставляют больше возможностей, чем другие. Если вы 
используете программу Photoshop, Fireworks или PaintShop Pro, не за-
будьте воспользоваться специальными инструментами для сохранения 
веб-графики

Начните с изображения RGB, имеющего наилучшее качество — никогда 
не знаешь, в каких еще ситуациях потребуется его использовать. После 
обработки изображения (изменения размера, кадрирования, коррек-
ции цветов и т. д.), сохраните его в полном размере, чтобы у вас точно 
был хороший оригинал. Затем можно изменить размер изображения, 
сделав его подходящим для веб-страницы. Фактически, сегодня при-
нято создавать несколько изображений, ориентированных на разные 
размеры устройства, что является веской причиной для сохранения 
чистого, качественного оригинала. Закончив настройку размера (я рас-
скажу о методах его изменения далее в этой главе), следуйте представ-
ленным ниже инструкциям по сохранению файлов в форматах GIF, 
JPEG или PNG.

Adobe Photoshop

Откройте в программе Photoshop диалоговое окно Сохранить для 
Web и устройств (Save for Web & Devices) Файл ⇒ Сохранить для 
Web и устройств (File ⇒ Save for Web & Devices) (рис. 19.12) и выбе-
рите один из форматов из раскрывающегося списка. Когда вы сделаете 
это, на панели ниже отобразятся настройки, соответствующие данно-
му формату. Диалоговое окно Сохранить для Web и устройств (Save 
for Web & Devices) также показывает предварительный вид итоговых 
изображений и их размер. Вы можете сравнить изображения с раз-
личными настройками, например в формате GIF и в формате PNG-8, 
разместив их рядом. Как только вы выбрали тип файла и определили 
его настройки, нажмите кнопку Сохранить (Save) и присвойте фай-
лу имя.

Мы снова встретимся с диалоговым окном Сохранить для Web 
и устройств (Save for Web & Devices) позже в этой главе, когда будем 
менять размер изображений и работать с прозрачностью. Оно также 
встретится в главе 20, где мы обсудим различные настройки, относя-
щиеся к оптимизации.

Adobe Fireworks

После того как вы открыли изображение и выбрали режим предва-
рительного просмотра, можете выбрать тип файла на панели Опти-
мизировать (Optimize) (рис. 19.13). Когда закончите с настройками, 
выберите команду Экспорт (Export) в меню Файл (File) и присвойте 
графическому изображению имя.



Часть IV. Создание графических изображений для Всемирной паутины22

Знакомство с форматами

Photoshop

Выберите тип файла в диалоговом окне Сохранить для Web 
и устройств (Save for Web & Devices). Вы можете поменять 
настройки и сравнить получающиеся в результате изображе-
ния перед тем, как нажмете кнопку Сохранить (Save).

Рис. 19.12. Выбирать тип файла в программе Photoshop удобнее всего с помощью диалогового окна 
Сохранить для Web и устройств

 

Fireworks

Выберите тип файла на панели Оптимизировать 
(Optimize) перед экспортом графического изображения.

Рис. 19.13. Выбор типа файла на панели  Оптимизировать программы Fireworks
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PaintShop Pro

Команды Оптимизатор GIF (GIF Optimizer), Оптимизатор JPEG (JPEG 
Optimizer) и Оптимизатор PNG (PNG Optimizer) находятся в меню 
Файл ⇒ Экспорт (File ⇒ Export). Каждая открывает диалоговое окно 
с настройками для соответствующего типа файла и предварительным 
просмотром сжатого изображения. Вкладка Цвета (Colors) диалогово-
го окна Оптимизатор GIF (GIF Optimizer) показана на рис. 19.14. Когда 
вы выполните все настройки, нажмите OK. Обратите внимание, что вам 
нужно выбрать тип вашего файла до того, как вы получите доступ к на-
стройкам, и нет способа сравнить предварительный вид изображений 
различного типа, как это возможно в программах Photoshop и Fireworks.

Рис. 19.14. Инструмент оптимизации изображений в программе Corel 
PaintShop Pro

Размер и разрешение изображения

Изображения формата GIF, JPEG и PNG объединяет то, что все они 
являются битовыми изображениями (также называемыми растровы-
ми). При увеличении растрового изображения вы можете увидеть, что 
оно похоже на мозаику, состоящую из большого количества пикселов 
(крошечных квадратов одного цвета). Это отличает их от векторной 
графики, которая состоит из плавных линий и заполненных областей 
и полностью основана на математических формулах. Рис. 19.15 демон-
стрирует разницу между растровой и векторной графикой.
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Размер и разрешение изображения

Vector images use mathematical
equations to define shapes.

Bitmap images are made up of a grid of
variously colored pixels, like a mosaic.
Растровые изображения состоят из та-
блицы пикселов разных цветов, похожих 
на мозаику.

Векторные изображения используют 
математические уравнения для опреде-
ления форм.

Рис. 19.15. Растровая и векторная графика

Прощайте, дюймы, здравствуйте, пикселы!

Если вы использовали растровые изображения для печати или для Все-
мирной паутины, вам может быть уже знаком термин разрешение  — ко-
личество пикселов на дюйм. В мире печати разрешения изображения, 
равные 300 и 600 пикселов на дюйм (ppi), являются наиболее распро-
страненными.

Однако во Всемирной паутине понятие дюймов неуместно. И хотя 
я могу создавать изображение с разрешением 72 пиксела на дюйм, вряд 
ли при отображении оно будет размером точно один дюйм (рис. 19.16). 
Фактически с появлением экранов с высокой плотностью пикселов, 
таких, как дисплеи Retina, даже понятие «дюйма» стало гораздо более 
запутанным, о чем говорится в следующем разделе «Пиксельное безу-
мие» и во врезке «Дисплеи с высокой плотностью пикселов».
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Рис. 19.16. Значения «точки на дюйм» не подходят для цифровых 
устройств, где размер изображения зависит от разрешения монитора
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Если мы отбрасываем дюймы, то придется отбросить и пикселы на 
дюйм. Единственное, что мы знаем наверняка, что изображение на 
рис. 19.16 составляет 72 пиксела по диагонали, и он будет в два раза 
шире графического объекта, который состоит из 36 пикселов по диаго-
нали. Веб-дизайнеры измеряют свои изображения по общему количе-
ству пикселов, поэтому технически разрешение изображения не имеет 
смысла.

Однако при этом большинство знакомых мне дизайнеров создают изо-
бражения с разрешением 72ppi, чтобы они были приблизительно нуж-
ного размера. Я обнаружила, что, когда я создаю изображения с таким 
разрешением и просматриваю их в программе Photoshop в масштабе 
100%, они сохраняют свои пропорции друг относительно друга и ото-
бражаются примерно такого же размера, как на экране настольного 
компьютера. Разрешение 72ppi также замечательно подходит в каче-
стве первоначального при создании изображений для дисплеев с высо-
кой плотностью пикселов (таких, как Retina) — просто увеличьте раз-
меры в пикселах в два раза.

Пиксельное безумие

Не так давно мы могли рассчитывать, что пикселы в изображении бу-
дут один к одному совпадать с аппаратными пикселами монитора ком-
пьютера. По большей части это все еще верно, но технологические до-
стижения уже нарушают данное правило.

Во-первых, многие браузеры теперь автоматически масштабируют 
большие изображения, чтобы они поместились внутри окна, незави-
симо от его размеров, и позволяют пользователям увеличивать веб-
страницы так, что пропорция 1:1 при отображении теряется. Кроме 
того, масштаб изображений явно уменьшается, чтобы они поместились 
на экранах маленьких портативных устройств.

Производители делают разрешение экрана все выше и выше. В ре-
зультате фактические аппаратные пикселы становятся настолько 
малы, что, если изображения и текст будут отображаться в масштабе 
1:1, они окажутся крошечными и неразборчивыми. Чтобы компенси-
ровать это, устройства используют единицу измерения под названи-
ем референсные пикселы , которым соответствуют пикселы в изобра-
жениях, тексте и правилах CSS. На дисплеях Retina новых моделей 
устройств iPhone, iPad и MacBook Pro ширина референсного пиксела 
равна двум аппаратным. На некоторых планшетах под управлением 
операционной системы Android референсный пиксел составляет 1,5 
аппаратного. Это выводит нашу работу как веб-дизайнеров на новый 
уровень сложности (см. врезку «Дисплеи с высокой плотностью пик-
селов»).

Точки на дюйм

Поскольку графические изо-
бражения для Всемирной 
паутины существуют только на 
экране, правильно измерять 
их разрешение в пикселах на 
дюйм  (ppi).

Когда дело доходит до печати, 
устройства и печатные стра-
ницы измеряются точками на 
дюйм  (dpi), которые описывают 
количество напечатанных точек 
на каждый дюйм изображения. 
Значение dpi изображения 
может как соответствовать, так 
и отличаться от значения ppi.

В ходе своей работы вы можете 
встретить употребление тер-
минов dpi и ppi как синонимов 
(хотя это не верно). Важно по-
нимать разницу.

ПРИМЕЧАНИЕ

Для получения более подроб-
ной информации я рекомендую 
прочитать статью «A Pixel Identity 
Crisis» Скотта Келлума (www.
alistapart.com/articles/a-pixel-
identitycrisis/).
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Дисплеи с высокой плотностью 
пикселов

Представьте себе устройство, для реализации потен-
циала которого в полной мере требуются огромные 
изображения, но доступ к ним оно может получать 
через медленное 3G-соединение. Именно так произо-
шло с iPad 3, выпущенным весной 2012 года. Данная 
модель iPad щеголяет экраном Retina  с разрешением 
2048 ×1536 — это колоссальные 3,1 млн пикселов или 
около того. Вскоре после этого был выпущен компью-
тер MacBook Pro с дисплеем Retina с разрешением 
2800 ×1800, и я уверена, что тенденция использова-
ния экранов с высокой плотностью пикселов только 
набирает обороты.

Это нравится потребителям, потому что изображения 
получаются такие же четкие и точные, как при печати. 
Но новый монитор Retina временно сразил нас, веб-
разработчиков, наповал. Обычные изображения на 
мониторах Retina выглядят нечеткими и несколько 
пикселизированными. Чтобы заставить изображение 
выглядеть четко, вам придется в два раза увеличить 
его размеры и позволить браузеру уменьшить их до 
запланированных макетом. На рис. 19.17 стандарт-
ное изображение сравнивается с тем же, но вдвое 
большим, созданным специально для монитора 
Retina.

К сожалению, когда вы увеличиваете размеры веб-
изображения в два раза, вы в конечном итоге полу-
чаете в четыре раза больше пикселов и увеличенный 
в четыре раза размер файла. А как мы знаем, в Ин-
тернете производительность решает все. Устройства 
с экранами с высокой плотностью пикселов могут луч-
ше отображать изображения с высоким разрешением, 
но это не значит, что сети волшебным образом стали 
работать быстрее, чтобы их передавать.

Итак, что делать? Честно говоря, мы все еще продумы-
ваем стратегии, помогающие справиться с неизбежным 
натиском устройств с высоким разрешением. Указание 
требований к сайтам при высоком разрешении станет 
еще одним аспектом работы веб-дизайнеров. Ниже при-
ведены несколько моментов, которые следует учитывать:

• Удвоение размеров изображений заставляет их 
выглядеть четко при высоком разрешении, как 
показано на рис. 19.17.

• Браузер Safari корпорации Apple, имеет ограниче-
ние на то, сколько мегабайт изображения в фор-
мате JPEG он может отображать на странице. Для 
файлов, размер которых более 2 мегапикселов 
(2,1 млн пикселов), он автоматически снижает 
разрешение изображения и четкость теряется. 
Чтобы обойти ограничение Safari для файлов JPEG, 

сохраните изображение в прогрессивном формате 
JPEG.

• Необязательно, чтобы все изображения были 
огромного размера. Подумайте об увеличении 
в два раза только для наиболее важных изобра-
жений на странице. К ним может относиться одна 
картинка, задающая настроение, ваш логотип или 
фотографии товаров, где важны такие детали, как 
текстура ткани.

• Допустимо использовать медиазапросы CSS, чтобы 
проверить, имеет ли устройство экран с высокой 
плотностью пикселов, и предоставить достаточно 
крупные изображения только в этом случае, не по-
зволяя небольшим устройствам получать неоправ-
данно крупные изображения. Вы также можете ис-
пользовать JavaScript, чтобы заменить стандартное 
изображение увеличенным в два раза.

• К сожалению, знание о том, что у пользователя 
есть устройство с дисплеем Retina или другим 
экраном с высокой плотностью пикселов, не со-
общит вам ничего о скорости соединения, так что 
вы рискуете отправить гигантское изображение 
посредством медленного соединения, которое не 
позволит быстро отобразить картинку. Стратегии 
для определения текущей скорости соединения 
пользователя находятся в стадии разработки 
и выходят за рамки этой главы, посвященной 
изображениям. Поскольку эти технологии быстро 
развиваются, я рекомендую вам самим поискать 
во Всемирной паутине последние идеи.

На экранах с высокой плотностью пикселов стандарт-
ные изображения выглядят размытыми. Изображе-
ние PNG шириной 350 px находится внутри элемента 
img, ширина которого задана 350px.

Изображения выглядят четкими на экранах с высо-
кой плотностью пикселов, когда их размер в два раза 
превышает конечный размер в макете. Изображение 
PNG шириной 700 px находится внутри элемента 
img, ширина которого задана 350px.

Рис. 19.17. Обычные веб-изображения выглядят 
немного пикселизированными на дисплее Retina 
планшета iPad
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Изменение размера изображения

Поскольку исходные изображения не подходят для Всемирной паути-
ны, уменьшение их размера занимает большую часть времени, которое 
я трачу на создание графики, так что это хороший базовый навык, ко-
торый непременно нужно приобрести.

В упражнении 19.1 я покажу вам легкий способ изменения размера изо-
бражения, который можно использовать в программе Photoshop посред-
ством команды Сохранить для Web (Save for Web). С помощью этого 
метода меняется размер экспортируемых графических изображений, 
а оригинал остается без изменений. Это упрощает сохранение копий одно-
го и того же изображения нескольких размеров для различных устройств. 
Для других программ (или если вы хотите лучше контролировать ито-
говое качество изображения), см. выноску «Использование диалогового 
окна Размер изображения», следующую за этим упражнением.

ПРИМЕЧАНИЕ

Если у вас нет программы 
Photoshop, вы можете загрузить 
бесплатную демонстрационную 
версию на странице creative.
adobe.com/products/photoshop.

УПРАЖНЕНИЕ 19.1. УМЕНЬШЕНИЕ РАЗМЕРА ИЗОБРАЖЕНИЯ В ПРОГРАММЕ 

PHOTOSHOP

В этом упражнении мы возьмем фотографию высокого разрешения и из-
меним ее размер так, чтобы она подходила под размер веб-страницы. 
Исходное изображение ninja.tif доступно в материалах для этой главы на 
диске, прилагающемся к книге.

Откройте файл ninja.tif в программе Photoshop. Выделите все пикселы 
в изображении с помощью команды Выделить ⇒ Все (Select ⇒ All), 
а затем проверьте размеры в пикселах на панели Информация (Info) или 
в диалоговом окне Размер изображения (Image Size) (рис. 19.18 �А ). 
Если панель Информация (Info) не открывается, выберите команду меню 
Окно ⇒ Информация (Window ⇒ Info). Если размеры указаны в дюймах 
или других единицах измерения, поменяйте их на пикселы, применив 
команду меню Редактирование ⇒ Установки ⇒ Единицы измерения 
и линейки (Edit ⇒ Preferences ⇒ Units & Rulers). Размер нашего изо-
бражения ниндзя 1600×1600 пикселов, оно слишком велико для веб-
страницы. Представим, что для этого примера отведено пространство 
400 × 400 пикселов в макете страницы.

Теперь мы изменим размер изображения и сразу же сохраним в фор-
мате JPEG. Выберите команду меню Файл ⇒ Сохранить для Web 
(File ⇒ Save for Web). В раскрывающемся списке Формат (Formats) вы-
берите пункт JPEG (�Б ). Установленные по умолчанию значения Высокое 
(High) и 60 в настройках хорошо подходят для этого примера.

С помощью группы элементов управления Размер изображения (Image 
Size) в нижней части диалогового окна (�В ) введите размеры, которые вы 
хотите присвоить итоговому изображению JPEG после сохранения, в дан-
ном случае 400 пикселов. При активном режиме Сохранить пропорции 
(Сonstrain Proportions) (значок цепи), высота меняется автоматически, 
когда вы вводите новое значение ширины.

Далее выберите значение в раскрывающемся списке Качество 
(Quality) (�Г ). При уменьшении размера лучший результат обеспечат вари-
анты Бикубическая (Bicubic) или Бикубическая четче (Bicubic Sharper). 
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Работа с прозрачностью

Форматы GIF и PNG предоставляют возможность сделать некоторые 
области изображения прозрачными, позволяя фоновому цвету просве-
чивать насквозь. В этом разделе мы подробно рассмотрим приемы ра-
боты с прозрачными областями, включая советы о том, как их создать.

Существует два типа прозрачности. При бинарной прозрачности  пик-
селы либо полностью прозрачные, либо полностью непрозрачные, это 
как переключатель. Файлы как формата GIF, так и формата PNG, под-
держивают бинарную прозрачность.

При альфа-прозрачности (или альфа-каналах) пикселы могут быть 
полностью прозрачными, полностью непрозрачными или находиться 
на одном из 254 уровней прозрачности (всего 256 уровней). Только 
формат PNG поддерживает альфа-прозрачность. Преимущество таких 

Вы увидите изображение с измененным размером на вкладке Оптимизация (Optimized) (выберите вкладку, если 
этого не произошло автоматически).

Нажмите кнопку Сохранить (Save) (�Д ), присвойте файлу имя и выберите папку, куда хотите его поместить. Ког-
да диалоговое окно Сохранить для Web и устройств (Save for Web) закроется, вы увидите, что исходный файл 
ninja.tif остался неизменным, так что вы можете подобным образом создать дополнительные изображения раз-
личных размеров. При сохранении файла сохраняются последние настройки экспорта.

 

Выделив изображение целиком, проверьте 
его высоту и ширину на панели Информация.

Рис. 19.18. Использование диалогового окна Сохранить для Web и устройств для изменения размера 
изображения
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изображений PNG заключается в том, что они сливаются воедино с лю-
бым фоновым цветом или рисунком, как показано на рис. 19.11.

В этом разделе вы узнаете о том, как работает каждый тип прозрачно-
сти, а также узнаете, как сделать в программе Photoshop изображение 
с прозрачными областями.

Как работает бинарная прозрачность

Помните, что цвета пикселов для файлов формата GIF и PNG-8 хра-
нятся в индексированной таблице цветов? Прозрачность — это просто 
отдельный цвет, занимающий позицию в ней. Рис. 19.20 демонстрирует 
таблицу цветов в программе Photoshop для простого прозрачного фай-
ла формата GIF.

Слоты в цветовой таблице, которые создают прозрачность, обозначены 
шахматным узором. Пикселы, которые соответствуют этим позициям, 
автоматически будут полностью прозрачными во время демонстрации 
изображения в браузере. Обратите внимание, что только один слот 
прозрачный, все остальные цвета пикселов — нет.

Использование диалогового окна 
Размер изображения

Недостатком метода, продемонстрированного в упраж-
нении 19.1, является то, что вы теряете контроль над 
качеством изображения. Если вы (как и я) хотите кон-
тролировать качество, то можете также предпочесть 
изменять размеры изображений в диалоговом окне 
Размер изображения (Image Size) (рис. 19.19). В про-
грамме Fireworks команда Изменение ⇒ Холст ⇒ Раз-
мер изображения (Modify ⇒ Canvas... ⇒ Image Size) 
предоставляет сходный набор функций.

Убедитесь, что установлены флажки Интерполяция 
(Resample Image) и Сохранить пропорции (Constrain 
Proportions), выберите в раскрывающемся списке 
настроек качества пункт Бикубическая (Bicubic) или 
Бикубическая, четче (Bicubic Sharper). Как мы уже го-
ворили ранее, для веб-графики разрешение не важно.

Затем введите желаемые конечные параметры в пиксе-
лах в верхней части окна и нажмите кнопку OK. Двойной 
щелчок мыши по инструменту масштабирования (увели-
чительное стекло, не показано) показывает изображе-
ние, размер которого был изменен в масштабе 100%.

Теперь вы можете применить фильтры усиления резкости 
и другие эффекты, а также использовать команду Сохра-
нить для Web (Save for Web), чтобы сохранить изображе-
ние в формате, подходящем для Всемирной паутины.

Рис. 19.19. Диалоговое окно Размер 
изображения программы Photoshop

Я считаю, что такой способ изменения размера очень 
больших изображений помогает сохранить каче-
ство. Сначала я меняю размер до среднего значения 
и применяю фильтр усиления резкости. Затем меняю 
размер до его финального значения и снова усиливаю 
резкость. Это нельзя сделать посредством команды 
Сохранить для Web (Save for Web).

ПРЕДУПРЕЖДЕНИЕ

Помните, что настройки в диалоговом окне Размер 
изображения (Image Size) меняют размер ориги-
нального изображения. Не сохраняйте его с тем же 
именем, иначе вы потеряете исходную версию высоко-
го качества!
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Как работает альфа-прозрачность

Изображения в режиме RGB, такие как JPEG и PNG-24, содержат цве-
та в отдельных каналах, один для красного, один для зеленого и один 
для синего. Файлы формата PNG-24 имеют еще один, добавочный, ко-
торый называется альфа-канал, он служит для хранения информации 
о прозрачности. В этом канале каждый пиксел может демонстрировать 
одно из 256 значений, которое соответствует 256 уровням прозрачно-
сти при отображении графического файла.

Черные области в альфа-канале отвечают за прозрачные области в изо-
бражении; белые —за непрозрачные; а серые — за разные уровни про-
зрачности между ними (рис. 19.21).

Black areas in the alpha channel
correspond to transparent image areas;

Original transparent image

Alpha
Red

Green
BlueСиний

Черные области в альфа-канале отвечают за прозрач-
ные области в изображении; белые —за непрозрачные; 
а серые — за разные уровни прозрачности между ними

Изображение с прозрачными областями

Альфа

Красный

Зеленый

Рис. 19.21. Информация о прозрачности хранится как отдельный 
(альфа) канал в 24-битном файле формата PNG

 

На прозрачные пикселы указывает слот с шахматным 
узором в таблице индексированных цветов.

Рис. 19.20. В таблице индексированных цветов прозрачность выступает в роли отдельного цвета
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Создание прозрачных файлов в форматах 
GIF и PNG

Самый простой способ сделать области изображения прозрачными — 
создать их такими изначально и сохранить в формате GIF или PNG. 
Еще раз отмечу, что команда Сохранить для Web (Save for Web) или 
панель Оптимизировать (Optimize) в программе Fireworks для данной 
цели являются наиболее совершенными инструментами.

Можно добавить прозрачные области в непрозрачном изображении со 
сведенными вместе слоями, но может оказаться сложным добиться бес-
шовного сочетания с фоном. Я рассмотрю процесс создания прозрач-
ных областей в существующем изображении позже в этом разделе.

Но сначала выполните упражнение 19.2, которое демонстрирует 
приемы сохранения прозрачных областей, позволяющие гарантиро-
ванно получить хорошее сочетание с фоном, используя диалоговое 
окно Сохранить для Web (Save for Web) программы Photoshop. Здесь 
я привела несколько новых концепций, так что даже если вы не вы-
полните упражнение, я рекомендую вам его прочитать, в частности 
шаги 5, 6 и 7.

ПРИМЕЧАНИЕ

Принципы и настройки, приведен-
ные в упражнении 19.2, прак-
тически идентичны программе 
Fireworks, так что можно приме-
нять те же самые общие инструк-
ции, хотя интерфейс немного 
отличается.

УПРАЖНЕНИЕ 19.2. СОЗДАНИЕ ПРОЗРАЧНЫХ 

ИЗОБРАЖЕНИЙ

В этом упражнении мы начнем с самого начала, так 
что вы получите опыт создания многослойного изо-
бражения с прозрачными областями. Пример прост, но 
вы, безусловно, можете применить эти техники к более 
сложным дизайнам.

�А

�Б
�В

�Г

�Д

Рис. 19.22. Создание нового изображения 
с прозрачным фоном

1. Откройте программу Photoshop и создайте новый 
файл, выбрав команду меню Файл ⇒ Новый 
(File ⇒ New). Есть несколько настроек в диалого-
вом окне Новый (New) (рис. 19.22), которые дадут 
вам правильное направление при создании гра-
фических изображений для Всемирной паутины.

• Создайте новое изображение шириной 500 
пикселов и высотой 100 пикселов для соот-
ветствия примеру в этом упражнении (�А ).

• Установите разрешение 72 пикс/дюйм (�Б ), 
именно такое я устанавливаю при создании 
веб-изображений (хотя, как вы узнали, на 
самом деле это не имеет значения).

• Убедитесь, что выбран 8-битный цветовой 
режим RGB (�В ).

• Наконец, что самое важное в этом упраж-
нении, выберите значение Прозрачный 
(Transparent) в раскрывающемся списке 
Содержимое фона (Background Contents) 
(�Г ). Так вы создадите файл Photoshop с про-
зрачным фоном. Намного проще изначально 
создать прозрачные области в изображении, 
чем добавить их позднее. Прозрачные обла-
сти (в этом случае, все изображение, посколь-
ку мы еще не добавили никакой графический 
контент) обозначено серым шахматным 
рисунком (�Д ).
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2. Теперь добавим немного текста и сделаем так, 
чтобы он отбрасывал тень (рис. 19.23).

• Выберите инструмент Текст (Text) (�Е ) 
и введите ваше имя. Откройте палитру 
Символ (Character), выбрав команду меню 
Окно ⇒ Символ (Window ⇒ Character) (�Ж ), 
чтобы изменить внешний вид шрифта. Выдели-
те текст и выберите полужирный шрифт (Bold) 
(какой-нибудь потолще), а также установите 
достаточно большой размер, чтобы заполнить 
окно документа, как показано в примере. 
Откройте палитру Образцы (Swatch) и исполь-
зуйте цветовую палитру, чтобы выбрать цвет 
для текста, который не должен быть слишком 
светлым и темным.

• Затем нужно добавить к тексту мягкую 
тень. Откройте палитру Слои (Layers) (�З ), 
выбрав команду меню Окно ⇒ Слои 
(Window ⇒ Layers). В списке вы увидите слой, 
содержащий текст. Добавьте тень, нажав 
кнопку Стиль слоя (на ней изображены буквы 
fx) в нижней части палитры и выбрав пункт 
Тень (Drop Shadow) (�И ). В появившемся 
диалоговом окне стилей слоя (�К ) вы можете 
поэкспериментировать с настройками, но 
я рекомендую установить значения параме-
тров Смещение (Distance) и Размер (Size), по 
меньшей мере, 5 пикселов, чтобы получить 
максимальный эффект. Когда вы закончите, 
нажмите кнопку OK.

3. В случае необходимости, сохраните изображение 
в формате PSD, чтобы поработать над слоями 
в дальнейшем. Я назвала файл saveliy.psd (исполь-
зуйте расширение .psd). Теперь у вас есть сохранен-
ное исходное изображение, и вы готовы приступить 
к подготовке его версии для Всемирной паутины.

4. Не закрывая файл, выберите команду Сохранить 
для Web (Save for Web) из меню Файл (File). Пере-
йдите в верхней части окна на вкладку 4 варианта 
(4-Up), чтобы сравнить оригинальное изображение 
с несколькими другими версиями (рис. 19.24). 
Обратите внимание, ваши окна предварительного 
просмотра будут представлены в виде таблицы.

5. Давайте посмотрим, как выглядит изображение 
в формате GIF с прозрачностью и без. Щелкни-
те мышью по второму окну предварительного 
просмотра, чтобы выбрать его, потом установите 
тип файла GIF и выберите количество цветов 32. 
Теперь сбросьте и снова установите флажок Про-
зрачность (Transparency) (рис. 19.25).

• Если флажок Прозрачность (Transparency) 
сброшен (как показано слева), для заполне-
ния прозрачных областей в оригинальном 

изображении используется значение в рас-
крывающемся списке Матовый цвет (Matte 
color). Установите матовый цвет белым, чтобы 
ваш рисунок соответствовал моему примеру.

• Если флажок Прозрачность (Transparency) 
установлен (как показано справа), шахмат-
ный фон появляется в прозрачных областях 
изображения, обозначая те места, где фоно-
вый цвет или рисунок на веб-странице будет 
просвечивать. Если вы присмотритесь к обла-
сти, на которую падает тень, вы увидите, что 
оттенки серого смешаны с матовым цветом. 
Попробуйте поменять Матовый цвет (Matte 
color) и посмотрите, что произойдет с тенью.

�Е

�Ж

�З �И

�К

Рис. 19.23. Добавление текста, отбрасывающего 
мягкую тень

Рис. 19.24. Вкладка 4 варианта диалогового 
окна Сохранить для Web позволяет сравнивать 
четыре различных версии одного и того же 
изображения
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Прозрачные оттенки серого в тени сливаются с цветом, установленным в раскрывающемся списке Матовый цвет.

Рис. 19.25. Предварительный вид выключенной (слева) и включенной 
(справа) прозрачности в файле формата GIF

Прозрачные оттенки серого в тени останутся прозрачными в файле формата PNG-24.

Рис. 19.26. Предварительный вид выключенной (слева) 
и включенной (справа) прозрачности в файле формата PNG-24

СОВЕТ ДИЗАЙНЕРА

Секрет получения прозрач-
ного файла GIF, сливающе-
гося с фоном, заключается 
в том, чтобы использовать 
значения RGB фонового 
цвета веб-страницы (или 
доминирующего цвета 
фонового изображения) 
при выборе оттенка в рас-
крывающемся списке Ма-
товый цвет (Matte color). 
Если фон вашей страницы 
представляет собой раз-
ноцветное изображение 
или по каким-то другим 
причинам трудно подо-
брать сочетающийся цвет, 
делайте выбор в пользу 
матового цвета, который 
слегка темнее, чем преоб-
ладающий фоновый.

6. Оставьте на некоторое время предварительный 
просмотр файла в формате GIF и выберите следую-
щее окно предварительного просмотра. Выберите 
тип файла PNG-8 и попробуйте установить флажок 
Прозрачность (Transparency). Как и ожидалось, он 
ведет себя в точности так же, как и GIF, поскольку 
оба формата используют бинарную прозрачность. 
Предварительный вид должен выглядеть, как по-
казано на рис. 19.25.

7. Теперь выберите четвертое окно предваритель-
ного просмотра, укажите формат PNG-24 и уста-
новите флажок Прозрачность (Transparency) 
(рис. 19.26). Если флажок не установлен (слева), 
матовый цвет заполняет прозрачные области 
оригинального изображения. Но когда Про-
зрачность (Transparency) включена (справа), 
шахматный фон смешивается с областями, 
занятыми тенью. То же самое будет с фоном 
веб-страницы. Если вы установили флажок Про-
зрачность (Transparency), то параметр Матовый 
цвет (Matte) больше не доступен, поскольку нет 

необходимости указывать фоновый цвет страни-
цы — файл формата PNG с альфа-прозрачностью 
сольется с чем угодно.

Обратите внимание на размер прозрачного файла 
PNG-24. Мой около 8 Кб, в то время как прозрачная 
версия формата GIF имеет размер порядка 5 Кб, а про-
зрачный файл формата PNG-8 получился всего лишь 
размером 3.3 Кб. Значительно больший размер фай-
ла — это цена, которую вы платите за универсальную 
альфа-прозрачность.

8. Сохраните файл формата PNG-24 с установленным 
флажком Прозрачность (Transparency) и назовите 
файл, используя расширение .png (мой называет-
ся saveliy.png). Снова откройте диалоговое окно 
Сохранить для Web (Save for Web) и сохраните 
версию изображения с прозрачностью в формате 
GIF (убедитесь, что установлен белый Матовый 
цвет (Matte)). Используйте файл с расширением 
.gif. Мы будем использовать эти графические объ-
екты в следующем разделе.
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Как избежать появления гало

Теперь, когда получены несколько графических файлов с прозрачными 
областями, я расскажу, как разместить их на простой веб-странице с бе-
лым фоном. Для этого откройте текстовый редактор и создайте HTML-
документ, как показано ниже (для экономии места я пропустила часть 
DOCTYPE и информацию о наборе символов):

<html>

<head>

<title>Пример прозрачности</title>

<style>

body {

background-color: white;

}

</style>

</head>

<body>

<p><img src="saveliy.png" alt=""></p>

<p><img src="saveliy.gif" alt=""></p>

</body>

</html>

Когда я открываю файл в браузере, на белом фоне графика выглядит 
более или менее одинаково (рис. 19.27, слева). Но если я поменяю 
фоновый цвет веб-страницы на сине-зеленый (background-color: 
teal;), разница между альфа- и бинарной прозрачностью становится 
видна очень отчетливо (справа).

Альфа-прозрачность файлов формата PNG-8

Технически различные уровни прозрачности не ограничены 24-битными 
файлами формата PNG. Файлы формата PNG-8 можно делать такими 
также. Несмотря на использование альфа-каналов, они содержат раз-
ные уровни прозрачности в многочисленных слотах таблицы индекси-
рованного цвета. В результате размер файла получается потенциально 
меньше, чем такое же изображение, сохраненное в формате PNG-24 
с альфа-каналом.

На момент написания данной книги, только программа Fireworks по-
зволяла создавать файлы формата PNG-8 с разными уровнями прозрач-
ности, а браузеры плохо их поддерживали. Многие браузеры отображали 
их как файлы с простой бинарной прозрачностью. На данный момент это 
еще одна полезная черта формата PNG, которая остается практически 
неиспользуемой из-за нестабильной программной поддержки.

ПРИМЕЧАНИЕ

Программа Fireworks предостав-
ляет вам на выбор индексную 
или альфа-прозрачность для 
изображений в формате PNG-8. 
Подробнее об этом читайте во 
врезке «Альфа-прозрачность 
файлов формата PNG-8».
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PNG-24 (Альфа-
прозрачность)

GIF (Бинарная 
прозрачность)

Рис. 19.27. Разница между бинарной и альфа-прозрачностью 
становится очевидна, если вы меняете фоновый цвет страницы

Когда фоновые цвета меняются, файл формата GIF больше не соче-
тается с фоном, в результате получается уродливая бахрома, которую 
обычно называют ореол или гало. Гало  — это сглаженные края, которые 
смешались с цветом, отличающимся от фонового цвета страницы. Они 
являются потенциальной опасностью бинарной прозрачности, будь то 
формат GIF или PNG-8.

Появление гало можно предотвратить. Как вы только что видели, пара-
метр Матовый цвет (Matte color) в программах Photoshop и Fireworks 
позволяет легко добиться того, чтобы края графического изображения 
сливались с целевым фоновым цветом. Если цвет фона меняется, вы 
можете снова экспортировать файл формата GIF в формат PNG-8 с но-
вой настройкой в раскрывающемся списке Матовый цвет (Matte color). 
См. врезку «Альтернатива матовому цвету», чтобы узнать о том, что де-
лать, если в вашей программе нет настроек матового цвета.

Другой вариант — сохранить изображение как файл формата PNG-24 
с альфа-прозрачностью. Таким образом, вам не придется беспокоиться 
о фоновом цвете или орнаменте и не будет проблем, если он изменится 
в будущем. Однако эта альтернатива влечет за собой создание файла 
большего размера.

Добавление прозрачности в изображения 

после сведения

Можно добавить прозрачные области в изображение и после того, как вы 
сохранили его в формате GIF или PNG и объединили слои. Изображение 
GIF с желтым кругом на фиолетовом фоне, показанное на рис. 19.27, хо-
рошо сливается со сплошным фиолетовым фоном, но будет квадратным, 
если фон заменить на орнамент. Решение заключается в том, чтобы сделать 
фиолетовые области прозрачными, чтобы фон мог быть виден насквозь. 
К счастью, большинство графических инструментов легко позволяют это 
сделать посредством выбора цвета изображения, который вы хотите сде-
лать прозрачным, обычно инструментом Пипетка (Eyedropper).

В программе Photoshop инструмент Пипетка (Eyedropper) для выбора 
цвета, который следует сделать прозрачным, находится в диалоговом окне 
Таблице цветов (Color Table). Для его открытия выберите команду меню 
Изображение ⇒ Режим ⇒ Таблица цветов (Image ⇒ Mode ⇒ Color 
Table). Нажмите кнопку с изображением пипетки, потом на пиксел цвета 

ТЕРМИНОЛОГИЯ

Сглаживание

Сглаживание  — это небольшое 
размытие, которое применяется 
к закругленным краям рас-
тровой графики для создания 
более плавного перехода между 
цветами. Несглаженные края, 
напротив, обладают ступенча-
той структурой. Сглаженный 
текст и графика могут придать 
вашему изображению более 
профессиональный вид.

Альтернатива 
матовому цвету

Если вы используете графи-
ческий инструмент, в котором 
нет параметра, позволяющего 
выбрать матовый цвет, создай-
те новый слой внизу списка 
слоев и заполните его цветом 
фона вашей страницы. Когда 
вы выполните сведение слоев, 
то в результате изменения 
режима на Индексированные 
цвета (Indexed Color), сглажен-
ные края надлежащим образом 
смешаются с необходимым 
фоновым цветом. Просто 
сделайте его прозрачным во 
время экспорта в формат GIF 
или PNG, и ваше изображение 
будет без гало.
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изображения и он превратится в прозрачный (рис. 19.28). Чтобы сохра-
нить новое прозрачное графическое изображение, используйте команду 
Сохранить для web (Save For Web), как я уже рассказывала ранее.

Photoshop (версия 6 и более новые)

Используйте инструмент 
Пипетка в диалоговом окне 
Таблица цветов, чтобы 
изменить цвет пиксела на 
прозрачный.

Рис. 19.28. Создание прозрачных областей в программе Photoshop

Если вы присмотритесь, то сможете заметить, что все еще осталась 
бахрома из пикселов фиолетового цвета. Это означает, что изображе-
ние будет нормально выглядеть только на фиолетовом фоне. В других 
случаях останется надоедливое гало. К сожалению, единственный спо-
соб исправить его на изображении после сведения — это стереть край 
сглаживания, пиксел за пикселом. Даже если вы избавитесь от бахро-
мы, у вас могут остаться непривлекательные ступенчатые края. Также 
допустимо выбрать слой-маску, чтобы удалить области, которые не 
следует делать прозрачными, обязательно стерев сливающиеся края 
исходного изображения.

Если вы обеспокоены тем, чтобы ваш сайт выглядел профессионально, 
я бы сказала, что лучше создавать графическое изображение с нуля, за-
ботясь о том, чтобы эффекты гало не появлялись, чем тратить время, 
пытаясь их удалить. Это еще одна причина, по которой надо всегда со-
хранять файлы со слоями.

Знакомство с форматом SVG

До сих пор в этой главе уделялось внимание проверенным и надежным 
растровым форматам веб-изображений, но есть и другой многообе-
щающий вариант, с которым я хотела бы вас познакомить. Не совсем 

ПРИМЕЧАНИЕ

В программе Fireworks инстру-
мент Пипетка (Eyedropper) на-
ходится в нижней части панели 
Оптимизировать (Optimize). Ин-
струмент Добавить цвет к про-
зрачности (Add to Transparency) 
позволяет вам выбрать больше, 
чем один цвет пиксела и сде-
лать их прозрачными. Это может 
оказаться полезно для удаления 
нежелательных цветов по краям 
изображения.
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верно называть масштабируемую векторную графику (Scalable Vector 
Graphics, SVG ) «многообещающей», потому что спецификация нахо-
дилась в разработке с 1999 года и стала рекомендоваться только в 2003 
году, но благодаря улучшению поддержки браузерами, мы, вероятно, 
наконец сможем воспользоваться преимуществами, которые она пред-
лагает.

Как я уже упоминала в начале этой главы, формат SVG немного свое-
образный. В отличие от других форматов веб-изображений, SVG — 
формат векторных изображений, а значит, он содержит инструкции для 
рисования фигур, а не сетки пикселов. Поэтому SVG хорошо подходит 
для значков, логотипов, графиков и других изображений, состоящих из 
линий (рис. 19.29). Он не подходит для фотографий, хотя растровые 
изображения и даже видеоролики можно встраивать в SVG.

1920

100%

75%

50%

25%

1930 1940 1950 1960

“ben” , Open Clip Art

The Noun Project

Ozer Kavak, Open Clip Art Ghostscript tiger
Рисунок тигра с по-
мощью GhostscriptОзер Кавак, Open Clip Art

Рис. 19.29. Формат SVG идеально подходит для векторных 
иллюстраций

Масштаб векторных изображений можно очень сильно увеличить или 
уменьшить без изменения качества (рис. 19.30). Линии и текст оста-
ются четкими, независимо от того, просматриваются ли они размером 
100 пикселов или 10 000 пикселов — попробуйте выполнить это с рас-
тровым изображением! Сегодня, когда наши веб-дизайны и интерфей-
сы должны работать на устройствах любого размера, от смартфонов 
до мониторов с высокой плотностью пикселов, возможность создания 
единого изображения, которое выглядит великолепно во всех контек-
стах — это эпическая победа. Повсеместная поддержка SVG, конечно, 
решит некоторые вопросы, с которыми мы сталкиваемся при сохране-

ПРИМЕЧАНИЕ

Пара хороших источников бес-
платных иллюстраций в фор-
мате SVG — The Noun Project 
(thenounproject.com) и библиоте-
ка Open Clip Art (openclipart.org).
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нии разрешения изображения на экранах с высокой плотностью пик-
селов.

tiger.svg

10x 10x

tiger.giftiger.svg tiger.gif

Рис. 19.30. Векторные изображения SVG масштабируются без 
потери качества

Рисование с помощью XML

Основное отличие формата SVG в том, что инструкции по рисованию 
предоставляются на языке XML . Растровые изображения хранятся 
как по большей части непонятный код (если вы потрудитесь заглянуть 
внутрь), но изображения в формате SVG создаются текстовыми файла-
ми, которые, как правило, удобочитаемы. Давайте рассмотрим простой 
пример и текстовый файл XML, скрытый за ним. На рис. 19.31 пока-
зано изображение SVG, svg4u.svg, состоящее из синего квадрата, овала 
с градиентной заливкой и текста (не самый красивый рисунок, я знаю, 
но хорошая иллюстрация к теме).

SVG 4 U!
Рис. 19.31. Простое изображение в формате SVG svg4u.svg
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Ниже приведен файл, который создает это изображение. Если вчитать-
ся в него, я думаю, вы решите, что интуитивно он вполне понятен.

<?xml version="1.0" encoding="utf-8"?>

<svg version="1.1"

xmlns="http://www.w3.org/2000/svg"

xmlns:xlink="http://www.w3.org/1999/xlink"

width="450px" height="200px">

<linearGradient id="yellowgrad">

<stop offset="0" stop-color="#FFF200"/>

<stop offset="1" stop-color="#F15A29"/>

</linearGradient>

<rect x="50" y="50" width="100" height="100" fi ll="#4F5AA8"

stroke="#000000" stroke-width="4" />

<ellipse cx="100" cy="100" rx="50" ry="25" 
fi ll="url(#yellowgrad)" />

<text x="175" y="150" fi ll="rgb(200,0,0)" font-
family="Verdana"

font-weight="bold" font-size="50">SVG 4 U!</text>

</svg>

Рассмотрим подробнее, что происходит в файле svg4ru.svg. Так как это 
файл XML, он начинается с определения XML. Оно также должно при-
держиваться синтаксиса XML, поэтому вы заметите, что все элемен-
ты прописаны в нижнем регистре, все атрибуты заключены в кавычки, 
и все элементы закрыты (например, <rect />). Элемент svg задает 
область рисования, которая составляет 450 на 200 пикселов. Пикселы 
установлены по умолчанию как единицы измерения в SVG, поэтому 
вам не нужно добавлять обозначение рх. Атрибут xmlns означает «про-
странство имен XML», и он просто идентифицирует языки XML, ис-
пользуемые в документе.

Так, теперь рисование. Квадрат создается с помощью элемента rect 
(прямоугольник) ширина и высота которого заданы в размере 100 
пикселов. Вы можете видеть, что для указания положения, размеров, 
цвета заливки, стиля обводки и так далее используются атрибуты. По-
мимо rect в файле SVG содержатся элементы circle, ellipse, line, 
polygon, и polyline для рисования линий и форм.

В нашем примере элемент ellipse расположен по центру поверх ква-
драта, и его заливка выполнена с помощью градиента «yellowgrad», ко-
торый был создан с использованием элемента linearGradient ранее 
в документе. Текст в изображении содержится внутри элемента text, 
а стили к нему добавлены с помощью атрибутов, использующих синтак-
сис CSS. Хотя это и не показано в примере, в изображениях SVG также 
можно разместить растровые изображения с помощью тега image.

Конечно, язык SVG намного сложнее, чем я могу здесь описать, но для 
начала вы должны иметь общее представление о том, как он работает.
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Инструменты для работы с файлами 
в формате SVG

Технически все, что нужно для создания SVG графики — это текстовый 
редактор, но вы будете намного счастливее, если программа для рабо-
ты с графикой выполнит необходимые действия вместо вас. К счастью, 
в программе Adobe Illustrator при сохранении документа в раскры-
вающемся списке Формат (Format) можно выбрать пункт SVG (svg) 
и получить файл SVG! Если у вас нет программы Illustrator, загрузите 
редактор изображений Inkscape (рис. 19.32), который создан специаль-
но для работы с файлами в формате SVG (inkscape.org). Он работает 
в операционных системах Windows, OS X и Linux. Потребуется немно-
го времени, чтобы вы к нему привыкли, но более выгодной цены вы не 
найдете (он бесплатный).

Рис. 19.32. Редактор файлов SVG Inkscape с открытым исходным кодом

Добавление SVG-файлов на страницы

Изображения SVG можно добавить на веб-страницы с помощью эле-
ментов object, embed, или iframe. Спецификация HTML5 позволяет 
добавлять элементы svg напрямую, как часть HTML-документа без 
элемента-контейнера. На сайте W3Schools представлено неплохое 
краткое описание различных вариантов вложения файлов svg, а также 
их преимущества и недостатки: www.w3schools.com/svg/svg_inhtml.
asp. Этот материал быстро меняется, поэтому я рекомендую вам про-
вести небольшое исследование последних достижений.
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На момент написания книги элемент object, указывающий на внеш-
ний файл .svg, поддерживался браузерами лучше всего, поэтому я ис-
пользую этот метод в данном примере.

<!DOCTYPE html>

<html>

<head><title>SVG 4 U</title></head>

<body>

<object width="450" height="200" type="image/svg+xml"

data="svg4u.svg"></object>

<p>Дайте формату SVG шанс и посмотрите, на что он способен.</p>

</body>

</html>

Атрибуты width и height необходимы элементу object, чтобы заре-
зервировать определенное пространство под изображение. Если про-
странства окажется слишком мало, изображение будет обрезано. И, 
во избежание путаницы, рекомендуется указать тип файла (image/
svg+xml), чтобы браузеры знали, что делать. Наконец, атрибут data 
указывает на сам файл .svg.

Дополнительные возможности формата SVG

В нашем примере показан файл SVG, используемый для статических 
иллюстраций, но формат SVG обладает бо́льшими возможностями.

Анимация

Формат SVG включает в себя функции преобразования и перехода (те 
же самые, что и в CSS3), поэтому любую часть изображения SVG мож-
но анимировать, используя только синтаксис svg. Приведенный ниже 
код заставляет черный прямоугольник сокращаться и расширяться на 
50% в ходе двухсекундного цикла.

<rect width="150" height="150" fi ll="black">

<animate attributeName="width" values="0%;50%;0%" dur="2s"

repeatCount="indefi nite" />

<animate attributeName="height" values="0%;50%;0%" dur="2s"

repeatCount="indefi nite" />

</rect>

Использование сценариев

Так как все части файлов svg написаны на языке XML и являются ча-
стью DOM (структурированного набора объектов в документе), можно 
использовать код JavaScript, чтобы добавить рисункам в формате SVG 
какое-то поведение, например анимацию. Также можно использовать 
JavaScript для динамической отрисовки изображений на основе поль-
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Знакомство с форматом SVG

зовательского ввода в режиме реального времени, например для соз-
дания диаграммы или графика, реагирующего на значения, вводимые 
в форму.

Использование стилей

Я не говорила об этом в данной главе, но вы также можете изменять 
внешний вид элементов в изображениях SVG с помощью CSS.

Доступность

Содержимое изображения SVG указывается в XML-файле, так что оно 
потенциально более доступно, чем элемент canvas, существующий 
в виде абстрактной сетки пикселов. Кроме того, в элемент svg можно 
добавить теги title и description.

Поддержка браузерами

Все было так хорошо, но мне придется упомянуть о поддержке формата 
браузерами! На самом деле новости не такие уж плохие. Когда я это 
писала, текущие версии всех основных браузеров, как настольных, так 
и мобильных, в целом поддерживали изображения в формате SVG. 
И ситуация, вероятно, уже улучшится к тому времени, когда вы будете 
читать эту книгу. Для получения обновленной статистики посмотрите 
данные по SVG на сайте caniuse.com/#cats=SVG.

В мобильном пространстве предсказать поддержку SVG сложнее, по-
тому что производители могут отключить на конкретном устройстве 
функции, которые оно поддерживает.

Если вы решите изучить SVG для определенных видов графики, не за-
будьте протестировать их на широком спектре устройств и обязательно 
предоставьте резервные варианты на случай, если изображения не ото-
бразятся.

Для дополнительного чтения

Очевидно, в этой главе я смогла только поверхностно коснуться мас-
штабируемой векторной графики. Если у вас есть желание и возмож-
ность использовать их на своем сайте, вам придется самим поискать 
информацию. Также я рекомендую вам ознакомиться со следующими 
ресурсами:

• Книгой Курта Кагла «HTML5 Graphics with SVG & CSS» (O'Reilly 
Media).

• Книгой Шелли Пауэрс «Painting the Web» (O'Reilly Media). Несмо-
тря на то что она написана в 2008 году, в главе, посвященной SVG, 
представлен хороший обзор возможностей этого формата. Кроме 
того, в ней содержатся замечательные подробные сведения о дру-
гих графических форматах, CSS и обо всем визуальном контенте во 
Всемирной паутине.

SVG против Canvas

В главе 10 мы рассмотре-
ли HTML5-элемент canvas 
и API-интерфейс двухмерного 
рисования. Разница в том, что 
изображение в формате SVG 
рисуется с помощью языка 
структурной разметки, изобра-
жение в элементе canvas  — 
с использованием команд 
JavaScript. Оба они могут со-
держать изображения, видео, 
анимацию и динамические 
обновления в режиме реально-
го времени.

Элемент canvas лучше под-
ходит для быстрой перерисовки 
на ходу (в конце концов, это 
только пиксели), что делает 
его более подходящим для игр, 
редактирования изображений 
и сохранения изображений 
в растровых форматах. Формат 
SVG предлагает преимущества 
простоты написания сценари-
ев, анимации и доступности, 
однако, сложные документы 
требуют большей вычислитель-
ной мощности, чем предлагают 
элементы canvas.
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• Статьей по адресу www.w3.org/Graphics/SVG/IG/resources/
svgprimer.html. Она предоставит вам полное руководство по гра-
фике в формате SVG.

• На сайте www.w3schools.com/svg/svg_examples.asp опубликова-
ны примеры кода для создания многих фигур и специальных эф-
фектов.

Резюме

Если я все правильно объяснила, то теперь у вас должны быть фунда-
ментальные знания о подготовке графических изображений для Все-
мирной паутины, включая информацию о том, где найти графические 
файлы, в каком формате их сохранять, и как изменять размеры изобра-
жений так, чтобы они были пригодны для Всемирной паутины. Также 
вы должны понимать разницу между бинарной и альфа-прозрачностью 
и уметь создавать изображения, которые хорошо сочетаются с фоном 
веб-страниц. В вашем арсенале есть даже некоторые понятия, касаю-
щиеся формата SVG.

В следующей главе вы перейдете на новый уровень подготовки изобра-
жений и изучите все способы, как сделать графические файлы настоль-
ко маленькими, насколько это возможно, для быстрой загрузки.

УПРАЖНЕНИЕ 19.3. РАБОТА С ФАЙЛАМИ В ФОРМАТЕ SVG

С файлами в формате SVG можно забавно поиграть. Чтобы вы могли 
почувствовать, как они работают, я включила файл svg4u.svg и соответ-
ствующий ему HTML-файл в материалы упражнений к данной главе.

1. Откройте файл svg_test.html в браузере, который поддержива-
ет файлы такого формата. Вы должны увидеть рисунок SVG 4 U! 
(см. рис. рис. 19.31).

2. Откройте файл SVG в текстовом редакторе Блокнот (Notepad) или 
TextEdit.

3. Попробуйте перемещать элементы, настраивая их координаты Х и Y. 
Попробуйте изменить размеры. Измените цвет заливки. Каждый раз 
обновляйте файл svgtest.html в браузере, чтобы просмотреть изме-
нения.

4. Если вы почувствовали азарт, откройте статью «An SVG Primer for 
Today’s Browsers» (указана в списке ресурсов в разделе «Для до-
полнительного чтения») и попробуйте создать другие фигуры и линии. 
Или можете попытаться создать простое изображение в программе 
Illustrator, сохранить его как файл с расширением .svg, открыть в тек-
стовом редакторе и повозиться с кодом. Вам придется отсеивать 
большое количество лишнего материала, но вы должны быть в со-
стоянии распознать и отредактировать основные фигуры.
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